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OpenRoads Survey - Existing Utilities 
and Storm Sewers 

 

Overview 

ODOT’s field data collection process to collect the exiting drainage information has been accomplished 
using a variety of methods over the years. The OHDOT CADD Standards are designed to allow different field 
collection methods to be used to collect and process the drainage information. Support for multiple 
processes is intended to accommodate a variety of field data collection options. This document details 
various options for collecting drainage information using OpenRoads Designer with the OHDOT CADD 
Standards. 
 
In order for OpenRoads to display the existing drainage information on profiles and cross sections, a 3D 
model of the surveyed drainage information must be generated in addition to the normal 2D survey data 
processing. An example of 3D drainage information is shown below. 
 

 
Generating the 3D model can be accomplished by either the survey personnel or the d 
esign personnel, depending on the scope of services. It should not be assumed that a 3D model of the 
existing drainage or other utilities is a standard Survey deliverable unless specifically scoped or agreed 
upon. 
 
Bentley’s Drainage and Utilities software is used to generate the 3D model of the drainage information. This 
information is placed in a separate drainage basemap design file, not in the survey design file. An overview 
of the process to extract drainage information as 3D objects is detailed in this document. 
 
 

  



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

September, 2020 

 

OpenRoads Survey: Existing Utilities and Strom Sewers 400-2 

 

Field Survey Procedures 

The process for the data collection of existing storm sewer information for modeling is summarized below: 

Field Data Collection for Drainage Structures 

• Shoot the storm sewer structures using the ODOT field codes for drainage structures. 
• Shoot the invert of the drainage structure using the FLINE field code. If you are unable to shoot the 

invert, measure the depth and take a shot on the grate adding the depth to the rod height. The 
FLINE point is used to define the depth of the drainage structure when extracting the surveyed 
points to generate a 3D drainage model. If an FLINE point is not present, a default depth is used. 

Field Data Collection for Drainage Pipes 
Three potential workflows are provided for field personnel to collect the drainage pipe information. 
Providing three options allows the surveyor to choose the workflow that best meets field conditions and 
the preferred methodology. 
 
Each option is described in this document. 
 
Method 1: Using Mapping Codes to shoot each end of open pipes and culverts 
 
Method 2: Using a CSV file to draw the pipes 
 
Method 3: Using Attributes stored on the drainage points 
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ODOT Field Codes 
ODOT’s field code list provides feature codes for various storm sewer catch basins, manholes, and inlets. 
The complete feature code list for Survey use can be found in the OHDOT CADD Standards in the following 
folder: 
 

..\OHDOT\Standards\Survey Files\Field_Codes\ 
 
The code list in Trimble and Leika formats is also available in the same folder. 
 
This document provides additional information for the use of the drainage field codes, data collection, and 
survey processing procedures. 

Field Codes for Drainage Structures 
ODOT’s field code list provides feature codes for various storm sewer catch basins, manholes, and inlets.  
 
In the past, ODOT has used generic field codes for the data collection of storm and sanitary structures. As 
ODOT continues to move towards the increased use of 3D modeling, it will become increasingly important 
to generate surveys with storm sewer information that more accurately represents the size and location of 
the drainage structures found in the field. Codes for specific drainage structure types are provided in 
addition to the generic field codes as detained below. 
 
Note: The Generic codes listed below were originally removed from the OHDOT CADD Standards for 
OpenRoads. These codes were added back to the OHDOT Standards with the August 2020 update. 
Either the new code, or the old generic code may be used. 
 

New Code Generic Code Description 
CB-2-2B CBS Catch Basin No. 2-2B (Square Catch Basin) 

Use the code for catch basin No. 2-2A, 2-2B, 2-3, 2-4, 2-5, and 2-
6 

CB-3 CI Catch Basin No. 3 (Curb Inlet) 
Use the code for catch basin No. 3 and 3A 

CB-4  Catch Basin No. 4 
Use the code for catch basin No. 4 and 4A 

CB-5  Catch Basin No. 5 
Use this code for catch basin No. 5, 5A, 8, and 8A. 

CB-6  Catch Basin No. 6 
CB-7 CBR Catch Basin No. 7 (Round Catch Basin) 
I-2-6  Median Inlet No. 2-6 

Use this code for all No. 2 and 2A inlets 
I-3B MI Median Inlet No. 3 (Median Inlet) 
I-4B  Median Inlet No. 4 
MH-3 STMH This code places a cell for a Manhole No. 3 but should be used 

for all storm sewer manholes 
MH-3-SAN SSMH Manhole No. 3 

Use this code for all sanitary sewer manholes 
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The following codes are provided for the flow line at the top and bottom of drainage structures. 
 

Code Description 
FLINE Flow line at the bottom of the drainage structure 
FLTOP Low point elevation of the inlet or catch basin grate/top. 

 
The new field codes listed above are more specific than the generic field codes; however, these codes are 
still somewhat generic as they do not account for the various vault sizes that may be available for each 
structure type. ODOT’s Feature Definition library contains supplementary codes for specific structures and 
vault sizes that are not included in the data collector list. These supplementary codes may be used in the 
office to change the feature definition of specific drainage structures if needed. 
 
The complete list of features, including the supplemental feature definitions, can be reviewed in the Project 
Explorer dialog by accessing the OpenRoads Standards group. To view the available Feature Definitions 
for drainage items, navigate the hierarchy as shown on the following page. 

 
 
The Survey group contains the feature definitions for all ODOT’s field codes, as well as any supplemental 
codes. The Drainage group contains all the drainage related feature definitions as shown below. 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

September, 2020 

 

OpenRoads Survey: Existing Utilities and Strom Sewers 400-5 

 

 
 
The supplemental feature types for catch basins, inlets, and manholes can be used after the data has been 
processed to edit a specific survey point and change its feature definition to draw the appropriate plan 
view cell. 
 
To change the feature definition for a survey point to one of the supplemental field codes, select the point 
and choose the Properties icon. Key in the new Feature Code name 
 

 
The field code CB-4 was used in the field for 
this survey point. 
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To change the Field Code, simply key-in the new code. 
The supplemental catch basin field codes can be reviewed 
in the Project Explorer dialog as shown on the previous 
page. 
 
Changing the code to a different structure type results in 
the appropriate plan view cell being drawn for the 
structure. 
 
 
 
 
 
 
 
 
 
 
 

 
 

Additional information about the drainage field codes is provided on the following pages. 
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Code Description Plan View Cell 3D View 
CB-2-2B 
 
Equivalent 
generic 
code: 
 
CBS 

Catch Basin No. 2-2B 
 
Use this code for all square 
catch basins with a note 
designating the size of the 
vault and whether the 
structure has a side inlet. 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 
 

CB22B-X 
 

 

 

Notes: 
Shoot the center of the grate. 
 
Edit the field code in the office to use one of the other square catch basin types: 

• CB-2-2A 
• CB-2-3, CB-2-3SI 
• CB-2-4, CB-2-4SI 
• CB-2-5, CB-2-5SI 
• CB-2-6, CB-2-6SI 

 

 

Code Description Plan View Cell 3D View 
CB-3 
 
Equivalent 
generic 
Code: 
 
CI 

Curb Inlet No. 3. 
 
Also used for No. 3A which has 
one grate. 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 
 

CB3-X 
 

 
 

 

Notes: 
Shoot the low spot of the grate, at the face of curb in the center of the structure. 
 
Edit the field code in the office to use one of the other types: 

• CB-3A 
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Code Description Plan View Cell 3D View 
CB-4 Catch Basin No. 4 

 
Use this code for catch basin 
No. 4 and 4A. The vault size 
varies for the 4A structures. 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 
 

CB4-X 
 

 

 

Notes: 
Shoot the center of the grate. If the grate is slanted, take a second shot at the low point using the FLTOP field 
code. 
 
Edit the field code in the office to use one of the CB4A types: 

• CB-4A-42, CB-4A-48, CB-4A-54, CB-4A-60, CB-4A-66, CB-4A-72  

 

 

Code Description Plan View Cell 3D View 
CB-5 Catch Basin No. 5 

 
Use this code for catch basin 
No. 5, 5A, 8, and 8A. The vault 
size varies for the 5A and 8A 
structures. The 8 and 8A 
structures have a v-shaped 
grate. 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

CB5-X 
 

 

 

Notes: 
Shoot the center of the grate. If the grate is slanted, take a second shot at the low point using the FLTOP field 
code. 
 
Edit the field code in the office to use one of the CB-5A or CB-8A types: 

• CB-5A-42, CB-5A-48, CB-5A-54, CB-5A-60, CB-5A-66, CB-5A-72 
• CB-8A-42, CB-8A-48, CB-8A-54, CB-8A-60, CB-8A-66, CB-8A-72 
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Code Description Plan View Cell 3D View 
CB-6 Catch Basin No. 6 

 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

CB6-X 
 

 

 

Notes: 
Shoot the back of the grate. 

 

 

Code Description Plan View Cell 3D View 
CB-7 
 
Equivalent 
generic 
Code: 
 
CBR 

Catch Basin No. 7 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

CB7-X 
 

 

 

Notes: 
Shoot the center of the grate. For domed grates, add the height of the dome (approximately 4”) to the rod 
height. A flat grate is used for the 3D model. 
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Code Description Plan View Cell 3D View 
FLINE Flow line at the bottom of the 

drainage structure 
GTM 

 

NA 

 

 

Code Description Plan View Cell 3D View 
FLTOP Low point elevation of the 

inlet or catch basin grate/top. 
GTM 

 

NA 

 

 

Code Description Plan View Cell 3D View 
I-2-6 Median Inlet No. 2 

 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

I26-X 
 

 

 

Notes: 
Shoot the flow line elevation at the center of the opening. These inlets come in various sizes from 6’ to 20’ in 
length, in 2’ increments. 
 
I-2 median cells are 3.0’ wide.  I-2A median cells are 3’-4” wide. 
 
Edit the field code in the office to use one of the I-2 or I-2A types: 

• 1-2-6, 1-2-8, 1-2-10, 1-2-12, 1-2-14, 1-2-16, 1-2-18, 1-2-20 
• 1-2A-6, 1-2A-8, 1-2A-10, 1-2A-12, 1-2A-14, 1-2A-16, 1-2A-18, 1-2A-20 
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Code Description Plan View Cell 3D View 
I-3B 
 
Equivalent 
generic 
code: 
 
MI 

Median Inlet No. 3 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

I-3B-SS-X 
 

 

 

Notes: 
Shoot the center of the grate. 

 

 

Code Description Plan View Cell 3D View 
I-4B Median Inlet No. 4 

 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

I-4B-SS-X 
 

 

 

Notes: 
Shoot the approximate center of the structure on top of the barrier. Measure the barrier height and add that 
value to the rod height to set the elevation for the grate. 
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Code Description Plan View Cell 3D View 
MH-3 
 
Equivalent 
generic 
code: 
 
STMH 

Storm Manhole 
 
Use this code for all storm 
sewer manhole types. 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

MH3-48D-X 
 

 

 

Notes: 
Shoot the center of the lid. 
 
The plan view cell origin is at the center of the base, not at the center of the lid. As a result, the manhole 
position will be shifted in relation to the survey shot at the center of the lid. The bigger the vault, the more the 
shift. Take a second shot at the approximate center of the base on the surface of the ground. Code this shot 
using the X2D feature code with a note to designate this as the actual center of the structure. In the office, edit 
the survey point to use the Northing and Easting coordinate of the X2D shot with the elevation from the shot 
on the lid. 
 
Edit the field code in the office to change the manhole type appropriately 

• MH-1 
• MH-2-12, etc… 
• MH-3-48, etc... 
• MH-4-72, etc… 
• MH-5-30, etc… 
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Code Description Plan View Cell 3D View 
MH-3-
SAN 
 
Equivalent 
generic 
code: 
 
SSMH 

Sanitary Manhole 
 
Attributes: 
P1, P2, P3, P4, P5, N1 
 
Pipe attributes (P1, P2…) are 
entered in the following 
format: 
Dip-Size-Material-Direction 
 
N1 is used for notes. 

MH1D-X-SAN 
 

 

 

Notes: 
Shoot the center of the lid. 
 
The plan view cell origin is at the center of the base, not at the center of the lid. As a result, the manhole 
position will be shifted in relation to the survey shot at the center of the lid. The bigger the vault, the more the 
shift. Take a second shot at the approximate center of the base on the surface of the ground. Code this shot 
using the X2D feature code with a note to designate this as the actual center of the structure. In the office, edit 
the survey point to use the Northing and Easting coordinate of the X2D shot with the elevation from the shot 
on the lid. 
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Drainage Pipes and Culverts 
This section documents the field codes and procedures to collect drainage pipe information. 
 
Three potential workflows are provided for field personnel as detailed on the following pages. Providing 
three options allows the surveyor to choose the workflow that best meets field conditions and the 
preferred methodology. 
 

• Method 1: Using Mapping Codes to shoot each end of the pipe 
This method is best for open pipes where both ends of the pipe can be located and a shot is taken at 
each end of the pipe. The mapping codes BL* (begin line) and EL* (end line) are used to connect the 
points to draw the linework for the drainage pipes. ODOT has added a visual basic application to 
the OHDOT CADD Standards with the August 2020 update that reads the SIZE attribute to 
automatically draw a dual-line custom line-style for pipes 12” or greater as the survey data is 
processed. The width of the line-style is defined by the value of the SIZE attribute. This method is 
not recommended for pipes connecting to a drainage structure since it requires a shot on the end of 
the pipe. 

 
• Method 2: Using a CSV file to draw the pipes 

For those who prefer to use a spread sheet or field notes to record the drainage pipe information, 
the pipe information may be defined in a CSV file that is processed using an ODOT Visual Basic 
application after the survey information has been processed with OpenRoads Survey. The format 
for the CSV file is defined in this document. This method does not require the use of attributes in the 
data collector. 

 
• Method 3: Using Attributes stored on the drainage points 

This method allows the surveyor to store information about the drainage pipes as attributes on the 
drainage structure point as the point is data collected in the field. These attributes define the dip, 
size, material, and direction of each pipe that is found in the drainage structure. Since mapping 
codes (BL* and EL*) are not used, graphics for the drainage pipes are not drawn when the survey 
information is processed with OpenRoads Survey. The pipes are drawn after the survey data has 
been processed using an ODOT provided Visual Basic Application. 

 
 
  



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

September, 2020 

 

OpenRoads Survey: Existing Utilities and Strom Sewers 400-15 

 

Method 1: Open Pipes and Culverts using Mapping Codes (BL*, EL*) 
The field codes listed below are available for the field collection of drainage pipes and culverts when both 
ends of the pipe can be located and a shot is taken on each end using the BL* and EL* mapping codes. 
 
Note: These codes were initially removed for the OHDOT OpenRoads CADD Standards and have been 
restored with the August 2020 update to the standards. 
 

Field Code Description Attributes Instructions 

CPP Corrugated Plastic Pipe Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

CMP Corrugated Metal Pipe Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

CMPA Corrugated Metal Pipe 
Arch 

Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

CULV Culvert Size - in feet 
Location 
Condition 

Shoot the ends of the culvert at the invert using 
the BL* and EL* mapping codes. 
 
The size is entered in rise x span format. 
Example: 6x10 

DP Drive Pipe Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

RCP Reinforced Concrete Pipe Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

RCPA Reinforced Concrete Pipe 
Arch 

Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

SMP Smooth Metal Pipe Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 

VCP Vitrified Clay Pipe Size - in inches 
Location 
Condition 

Shoot the ends of the pipe at the invert using 
the BL* and EL* mapping codes. 
 
For elliptical pipes, the size is entered in rise x 
span format. Example: 12x18 
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These field codes are intended to be used when both ends of the pipe can be located and a shot is taken on 
the invert at each end of the pipe. The BL* and EL* mapping codes are used with these field codes. 
 
When these field codes are processed, a Visual Basic application automatically reads the Size attribute to 
draw the drainage pipe and to annotate the pipe information. Pipes 12” or greater are drawn at the proper 
width using a custom line style.  
 
Example: 
 
The reduced field data below represents two pipes collected using the BL* and EL* mapping codes. 
 

SV108,1080,1000,1000,RCP BL*,SIZE,36,LOCATION,INVERT,CONDITION,GOOD 
SV109,1080,1050,1001,RCP EL*,SIZE,36,LOCATION,INVERT,CONDITION,GOOD 
SV110,1100,1000,1000,RCPA BL*,SIZE,18x24,LOCATION,INVERT,CONDITION,GOOD 
SV111,1100,1050,1001,RCPA EL*,SIZE,18x24,LOCATION,INVERT,CONDITION,GOOD 

 
When the data is processed using OpenRoads Survey, the pipes are drawn and annotated as shown in the 
example below. 
 
Notes: 
The text size is determined by the Annotation Scale setting. 
 
Changing the annotation scale setting does not change the 
length of the flow line. 
 
The text is placed above the line in the direction of flow. 
This may result in text that is upside-down. Since the survey 
data will most likely be rotated when plan sheets are 
produced, there is no sense in rotating the text as it may 
still appear upside-down in relation to the final sheets. 
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Method 2: Pipes and Culverts using a CSV file 
Some surveyors may prefer to collect the pipe information separately for post processing using a CSV file 
containing the drainage pipe information. This method can be used for pipes connecting to a drainage 
structure or for open drainage pipes and culverts without use of the BL* EL* mapping codes or attribute 
information. 
 
After the data has been processed using OpenRoads Survey, the ODOT visual basic application 
OHDOT_ExistingStormSewer.mvba is used to read a CSV file to draw the drainage pipe information. 
 
The various drainage structure field codes along with the codes listed below are used when data collecting 
the drainage pipe information in the field that will be drawn with a CSV file. 
 

Code Description Plan View Cell 3D View 
FDO For Direction Only 

 
Used to show the direction of 
a pipe when the other end 
cannot be located 

SVPT 

 

NA 

PIO Pipe Inlet/Outlet. 
 
Shoot the invert of the pipe 
 
Attributes: 
P1 
 
If used, the attribute P1 is 
entered in the following 
format: 
Dip-Size-Material-Direction 

SVPT 

 

NA 

Notes: 
Shoot a point at each end of the pipe using the PIO field code. If one end of the pipe cannot be located, use the 
FDO field code to take a shot in the direction of the pipe. 
 
The BL* and EL* mapping codes should not be used with these field codes. Using this method, both ends of an 
open pipe should be collected using the PIO field code and later connected using an ODOT visual basic 
application with a CSV file. 

 
Using this process, the drainage pipe information is read from a CSV file and processed using an ODOT VBA 
Application. The CSV file format is defined below. This method can be used for open pipes (connecting two 
PIO shots), culverts (connecting two CULV shots), and for pipes connected to a drainage structure at one or 
both ends. 
 
ODOT provides a template Excel file that can be used to collect the pipe information. The template Excel 
files is found in the following location: 
 

..\OHDOT CADD\Standards\Survey Files\OHDOT_ExistingStormSewers.xlsx 
 
The data must be exported from the Excel file to a CSV file for processing. Custom Excel files can also be 
used as long as the required information is saved to a CSV file in the format documented below. The first 
few lines of an example CSV file are shown below: 
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The order of the fields in the CSV file is fixed and cannot be modified. Each field is described below: 
 

Field Description 
First Point Name The point name for the drainage structure, PIO, or FDO point 
Depth or Elevation The measured depth to the pipe invert, or the actual elevation of the pipe invert. 

 
Notes: 

- If the value is greater than 200 it is assumed to be an elevation 
- Values less than 200 are subtracted from the First Point elevation when the 

CSV file is processed 
- Use a value of 0 for PIO and FDO points 

Size The pipe size, in inches 
- Use numbers only, do not append a double quote character to designate 

inches 
- Elliptical pipes are entered in rise by span format without any spaces or 

other characters. Example: 14x23 
Material The pipe material. Use only the abbreviations defined in the ODOT Excel file 
Second Point Name The point name for the other end of the pipe, a structure, PIO, or FDO point 
Depth or Elevation The measured depth to the pipe invert, or the actual elevation of the pipe invert. 

Notes: 
- If the value is greater than 200 it is assumed to be an elevation 
- Values less than 200 are subtracted from the First Point elevation when the 

CSV file is processed 
- Use a value of 0 for PIO and FDO points 

 

The First Point Name and Second Point Name values are the ORD Survey point number for a drainage 
structure, PIO, or FDO point. Pipes can be drawn between various points as listed below: 
 

• From a drainage structure to drainage structure 
• From a pipe inlet to a pipe outlet (PIO to PIO) 
• From a drainage structure to a pipe outlet (PIO) 
• From a drainage structure to a pipe direction shot (FDO) 
• From a pipe inlet of outlet to a pipe direction shot (PIO to FDO) 
• From a culvert point to a culvert point (CULV to CULV) 
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The OHDOT_ExistingStormSewer.mvba is used to process the CSV file. The application is accessed from 
the OHDOT WorkFlow in the Survey group as shown below. 
 

 
 
The dialog shown below is opened. 

 
The application requires a 3D model and must be run in the design file containing the Survey Field Book 
information. 
 
The application has three tabs: 
 

• CSV Input 
• Check Attributes 
• Manual Selection 

 
The CSV Input tab is used to read a CSV file containing existing pipe information and draw storm sewer 
and sanitary sewer pipes and culverts into the survey field book design file. 
 
The lines that are drawn for the pipes are drawn in 3D at the correct elevations, however these lines are 
“flat” lines using the ODOT line styles for drainage pipes and culvers. 
 
Select the CSV file and the Field Book. Choose the Process File option to initiate processing. An example 
of the plan graphics for the pipes drawn in the field book design file is shown below. 
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The pipe labels and flow arrows are placed using the active annotation scale and the active MicroStation 
text style. Changing the annotation scale after the CSV file has been processed will resize the text, but not 
the flow arrow length. 
 
As the CSV file is processed, the selected field book is searched for survey points matching the point names 
defined in the CSV file. If a point in the CSV file is not found in the selected field book, it is reported in a 
separate dialog as shown in the example below. 

 
The graphics in the survey basemap design file are intended for plan production purposes, not for 3D 
modeling. The 3D pipe information can be extracted from these graphics to generate a 3D model of the 
drainage features as described later in this document. 
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Method 3: Using Attributes Stored with the Drainage Points 
When this method is used, the surveyor enters pipe attribute information in the data collector as the 
drainage points are surveyed in the field. The attribute information for up to 5 pipes can be entered for 
each drainage structure. The attributes and the format are summarized below. 
 

Attribute Attribute Format  
P1 Dip-Size-Material-Direction Dip = The depth from the grate to the pipe invert 

Size= The pipe size in inches. Rise by Span for elliptical pipes 
Material = The pipe material, CONC, CMP, etc. 
Direction = The approximate direction of the pipe. N, S, SE, etc. 
Example: 3.75-12-CONC-S 

P2 Dip-Size-Material-Direction 
P3 Dip-Size-Material-Direction 
P4 Dip-Size-Material-Direction 
P5 Dip-Size-Material-Direction 
N5 Notes Use this attribute to enter any notes 

 
When the survey data is processed, the attribute information is stored with the drainage points. In the 
example below, information for 4 pipes was stored with the survey point. The attribute information is 
listed in the Attributes Pair field. 

 
The attribute information can be edited after the survey data is processed using OpenRoads Survey tools as 
described below. 
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Use the MicroStation Element Selection tool to select the drainage point. The attributes can be edited by 
selecting the icon to the to the right of the Attributes Pair list as shown below. 

 
When the icon is selected, the dialog shown below is opened 
to allow editing or adding attributes to the selected point. 
Select the Accept button after making edits. 
 

 
 
 
 
 
 
 
 
 
 

 
 
The OHDOT_ExistingStormSewer.mvba application is used to draw the pipes when attributes are used to 
define the pipe information. The application is accessed from the OHDOT WorkFlow in the Survey group as 
shown below. 
 

 
 
The dialog shown below is opened. 
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The application has three tabs: 
 
• CSV Input 
• Check Attributes 
• Manual Selection 
 
 
 
 
 
 

 
The CSV Input tab was described earlier in this document. The Check Attributes and Manual Selection 
tabs are used when drawing the drainage pipes using attribute data. 
 

• Check Attributes is used to review the OpenRoads Survey Field Book information to verify the 
format of the drainage attributes. This process should be run before using the Manual Selection 
functions 
 

• Manual Selection is used to connect drainage pipe information by manually selecting the survey 
points to be connected. The attribute data is read from the survey points selected in the design file 
to draw the drainage pipe in the design file 

 
When the Check Attributes tab is selected, the dialog appears as shown below. 

 

The Check button is used to run a check on the 

attribute data for the drainage points found in the 

selected Field Book. As each point is processed, the 

application verifies the format of the attribute data. 

Any points that do not meet the dip-size-material-

direction formation are listed in the dialog. 

The P1, P2, P3, P4, P5, and N5 fields are used to 

correct the attribute format. Attribute fields that are 

incorrect are highlighted in yellow as shown at left. 

Select Update Attributes to update the attribute data 

for the selected point. 
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The Review All button is used to generate a list of all the drainage points found in the selected Field Book.  

 

Select a point to review the attribute information. 

This function is useful to add attribute information to 

points from field notes, if desired. 

 

 

 

 

 

 

 

When the Manual Selection tab is selected, the dialog appears as shown below. 

 

Manual Selection mode is used to draw pipes and 
culverts by selecting two of the drainage points in 
the selected Field Book. 
 
This mode is useful for projects with only a few 
pipes when a CSV file will not be used. Like the CSV 
mode, the graphics drawn for the drainage pipes 
are placed at the computed elevation for the end 
points of the pipe. The graphics are “flat” lines 
intended for plan production. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

September, 2020 

 

OpenRoads Survey: Existing Utilities and Strom Sewers 400-25 

 

 
The Drainage Point 1 and Drainage Point 2 fields 
are used to select the points that will be used to draw 
a pipe or culvert. The point names must be contained 
in the selected Field Book. 
 
In the example at left, two points were selected that 
contain drainage pipe attributes. 
 

  
Select this icon to draw the pipe between the selected 
drainage points. The pipe is drawn using the Size and 
Material values of the pipe selected in the Drainage 
Point 1 pipe list. 
 

 
Select the icon to draw a pipe from Drainage Point 1 
to a data point location. The end of the pipe is placed 
at the same elevation as point 1. 
 
Note: The Size and Material is always annotated 
using the selected pipe for Drainage Structure 1. The 
application does not support labeling pipes that 
change size or material from one end to the other. 
 

 
 

If the selected pipe does not have any attributes, the application allows the user to enter values for the Dip, 

as shown below. 

 

The Dip value can also be entered as an elevation. Values 

greater than 200 are assumed to be elevations. 
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Field Codes for Box Culverts 
 

Code Description Plan View Cell 3D View 
CULV Flow line at each end 

of a box culvert.  
SVPT 

 

 
Notes: 
Shoot a point at each end of the culvert. 
 
The Attributes SIZE, LOCATION, and CONDITION are available. Use these attributes when using the 
BL* and EL* mapping codes to draw the culvert line. 
 
The SIZE attribute is entered in rise x span format. 

 
The example below shows the reduced coordinate field data for a 6x10 box culvert. 
 

SV124,1240,1000,1001,CULV BL*,SIZE,6x10,LOCATION,INVERT,CONDITION,POOR 
SV125,1240,1050,1000,CULV EL*,SIZE,6x10,LOCATION,INVERT,CONDITION,POOR 

 
The culvert graphics are drawn as shown below using a custom line style for the culvert size when the 
survey data is processed. 
 

 
Box culverts can also be processed using the OHDOT_ExistingStormSewers.mvba application. The 
process is like processing the PIO points as described previously in this document. When processing with 
the visual basic application, the mapping codes BL* and EL* are not necessary. 
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Exercise 1. Drainage Survey Example 

This exercise demonstrates the process to import survey data containing a few drainage structures, 

rotating the structures into place, and connecting the pipes using the OHDOT_ExistingStormSewers 

application to read a CSV file with the pipe information. 

Note that this example is an isolated dataset containing only a few points and no other topo survey 

information. It is not necessary to collect the drainage information as a separate dataset. Drainage 

information is normally included in the same dataset as the general topo survey information. This exercise 

is intended to illustrate the drainage structure and pipe connection process. 

Creating the Field Book (FB) design file 
For a newly created WorkSet, one of the seed files is used as the initial launching point to create new design 

files for the project. 

Take the following steps to open 106471_DesignSeed2d.dgn and create a new FB design file for the 

project. 

• Open ProjectWise Explorer 

 
 

• Browse to the folder shown below, using your home District and your use name. 
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• Right-Click on the file 106471_DesignSeed2d.dgn and choose the Open With… option to open the 

file with OpenRoads Designer CONNECT Edition. Toggle the Always use the program option ON 

 
• Select OK to open the file. 

 

• Select the Ohio DOT WorkFlow from the top left of the ORD interface. 

 

• From the Apps tab, select the OHDOT Create Design Files icon 

 
The application is opened as shown below 

 

• Create the following DGN file: 

 

300-Survey\Basemaps\106471_FB002.dgn 
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• Open the newly created FB file 

 

Importing Survey Data 
Create a new Field Book to import the drainage information 

• From the Explorer dialog, open the Survey group 

 

If the Explorer dialog is not displayed, open it by selecting Explorer on the Home tab of the Survey 

WorkFlow 

 

• Right-click on the Field Books option in the Explorer dialog’s Survey group to create a new Field 

Book as shown below.  

 

The field book is created with the default name “Field Book 1”. The name can be changed by 

selecting the field book in the Explorer dialog and entering the new name in the Properties dialog. 
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• Import the drainage survey information by right-clicking on the field book name in the Explorer 

dialog and choosing Import > File using Text Import Wizard 
o Browse to the following folder to select the CSV file containing the topo survey data 

300-Survey\SurveyData\FieldData\RawData\ 

 

o Open the file 106471_Drainage_Export_Scaled.csv 

The Text Import Wizard dialog is opened as shown below 

 

The Text Import Wizard can be used to import CSV files in a variety of formats. Users can elect to 

manually configure the settings or select one of ODOT’s predefined formats. 

ODOT provides three predefined formats for import as listed below.  

OHDOT-CommaPtNEZCode.tiw 

This file does not have a coordinate system defined. This file is used for projects that have a 

custom scale factor defined. 

OHDOT-CommaPtNEZCode-OH83-2011-NF.tiw 

This file is used to import CSV files that contain grid coordinates in the OH83-2011 North 

coordinate system. 

OHDOT-CommaPtNEZCode-OH83-2011-NF.tiw 

This file is used to import CSV files that contain grid coordinates in the OH83-2011 South 

coordinate system. 

These TIW files are in the following folder within the OHDOT standards: 
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03 Standards\CADD Standards\CONNECT_Config\OHDOTCEv01\Standards\Survey 

Files\TIW\ 

 

The files are configured for comma separated CSV files in the following format: 

 

Column 1 Format  = Point Name 

Column 2 Format  = Northing 

Column 3 Format  = Easting 

Column 4 Format  = Elevation 

Column 5 Format  = Code 

Column 6 Format  = Attribute Name 

Column 7 Format  = Attribute Value 

Column 8 Format  = Attribute Name 

Column 9 Format  = Attribute Value 

Column 10 Format  = Attribute Name 

Column 11 Format  = Attribute Value 

Column 12 Format  = Attribute Name 

Column 13 Format  = Attribute Value 

Column 14 Format  = Attribute Name 

Column 15 Format  = Attribute Value 

Column 16 Format  = Attribute Name 

Column 17 Format  = Attribute Value 

 

• Use the Open Existing tiw File option to select the following file from the folder listed above: 

 

OHDOT-CommaPtNEZCode.tiw 

 
The Back and Next buttons can be used to review the Text Import Wizard dialog settings prior to 

importing the data. 

 

• Select Finish to initiate the process. The CSV file is imported into the DGN file 

The data contains two drainage structures and a PIO (Pipe Inlet/Outlet) point. The point SV208 

representing a CB-4 is shown below. 
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Rotating Survey Points 
The concrete pad was also surveyed as shown above. The catch basin cell will be rotated to align with the 

concrete pad using the OHDOT_RotateSurveySymbols.mvba application. 

From the OHDOT WorkFlow, select the OHDOT Rotate Survey Symbols command. The dialog shown 

below is opened. 

 

The application is used to rotate survey cells relative to a selected line, 

line string, curve, curve string, or segment of a shape. See the Help 

document for more information not presented here. 

 

 

 

 

 

 

 

 

Take the following steps to rotate the catch basin cells relative to their individual concrete pads. 

• Select the reference element that will be used as the baseline to rotate the cell. The opposite end of 

the concrete pad was selected in the example below. 
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• Place a fence shape around the cells that you wish to rotate. In this example, we will only rotate one 

cell but keep in mind that multiple cells can be rotated simultaneously by placing a fence shape 

around a group of cells to rotate them relative to the selected element. 

 

Tip: Follow the prompts – issue a reset (right-click) to complete the fence shape placement. An 

example is shown below. 

 
All the cells found within the fence shape are listed as shown above. 

 

• Set the Rotation method to Tangent 

 

• Choose the Rotate Selected Elements button to initiate the process. The cell is rotated as shown 

below. 
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• Repeat the procedure for the other catch basin 

 

Drawing the Drainage Pipes using a CSV File 
After the cells have been rotated into place the next step is to connect the pipes between the drainage 

structures. This is accomplished by use of the OHDOT_ExistingPipes application. 

• From the OHDOT WorkFlow, select the OHDOT Existing Pipes command as shown below. 

 

The dialog shown below is opened. 

 

 

 

 

 

 

The application is used to draw storm or sanitary 

pipes between the drainage structures as 

previously detailed in this document. 

The CSV Input tab is used to select and process the 

CSV file containing the connecting pipe information 

 

 

 

Take the following steps to create and import a CSV file containing the pipe information: 

• A template Excel spread sheet with the proper headings defined is available in the OHDOT CADD 

Standards to use a starting point to create the CSV file. Copy the XLSX file from the following 

location: 

03 Standards\CADD Standards\CONNECT_Config\WorkSpaces\OHDOTCEv01\ 

Standards\Survey Files\OHDOT_ExistingStormSewers.xlsx 
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To the following folder for your project: 

 106471\300-Survey\SurveyData\FieldData\RawData\ 

 

• Rename the file as follows: 

106471_ExistingStormSewers.xlsx 

 

• Open the file from ProjectWise Explorer to edit the XLSX file. Include the information for each 

storm sewer pipe as show below: 

 
• After adding the information above, choose the Save As… option to save the file using the CSV 

(Comma Delimited) (*.CVS) option. 

 
• When prompted, Check In the file as shown below. 
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• Open the OHDOT Existing Pipes application 

 

• Select the Browse button to open the following CSV file: 

300-Survey\SurveyData\FieldData\RawData\106471_ExistingStormSewers.CSV 
 

• Select the Process File button. The pipes are drawn as defined in the CSV file. 

 

 
• After reviewing the pipe information, close and check-in the design file. 
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Exercise 2: Creating a 3D Box Culvert 

Box culverts are field collected using the CULV Code. The points are connected by use of the BL* and EL* 
mapping codes, or by using the ODHOT Existing Pipes application to draw the culvert lines between the 
surveyed points. The culvert lines can be drawn using the CSV Input process of the Manual Selection 
process as show in the example below. 

 
The 3D culvert information is drawn in a separate Drainage Basemap (BD) design file using the Drainage 
and Utilities tools. 
 

Important - Do not use the Field Book (FB) design file for this process! 
When a 3D culvert is generated, the ORD software will generate a utility database in the active file. For this 
reason, a separate design file is used. ODOT does not want a utility database generated in the Survey Field 
Book (FB) design file. 

 
Take the following steps to create the 3D box culvert: 
 

• Open ProjectWise Explorer 

 
 

• Browse to the folder shown below, using your home District and your use name. 
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• Right-Click on the file 106471_DesignSeed2d.dgn and choose the Open With… option to open the 

file with OpenRoads Designer CONNECT Edition. Toggle the Always use the program option ON 

 
• Select OK to open the file 
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• Select the Ohio DOT WorkFlow from the top left of the ORD interface. 

 

• From the Apps tab, select the OHDOT Create Design Files icon 

 
• Create the drainage basemap (BD) design file. Be sure to use the 2D seed file. 

 

• Open the drainage basemap (BD) design file 

 

• After creating a drainage basemap design file, attach the survey basemap as a reference file to view 

the culvert shots. Box culverts are surveyed using the CULV field code to take a shot at the invert 

elevation at each end of the culvert. 

The graphics for a box culvert is placed in a 2D model in the drainage (BD) basemap design file. The 
Drainage and Utilities software is used to place the box culvert in a 2D model. The software will 
automatically generate the 3D model for the box culvert. 
 
 

Each end of the culvert must first be defined as a “Node” using the Drainage and Utilities software. 
 

• From the Drainage and Utilities WorkFlow, select the Place Node command as shown below 
 

The first time the command is selected, the software 
will prompt whether to create a utility model in the 
file as shown below. Select Yes. 
 
 
 
 
 

 
 

The software will go through several 
steps to create the utility model. When 
complete, you must select the Place 
Node command again. 
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• Box culverts are placed using the Connect Conduit Between Nodes command. A node must first 
be placed at each end of the proposed box culvert in the design file by use of the Place Node 
command. The generic headwall feature definition is used to defile the location of each end of the 
box culvert.  

 
 

 
The Elevation is defined by selecting a 
Reference Element, or by keying in a 
value. 
 

 
 
The CULV point cannot be selected as a 
reference element. 
 
Tip: Float the cursor over the CULV point, 
allowing the cursor to rest on the 
element, to open the pop-up menu with 
the elevation information for the survey 
point as shown in the example below. 
 
After reviewing the point elevation, right-
click (reset) to key-in the elevation for the 
Node. 
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• Key-in the Elevation value of 1240.388 
 
By default, the generic headwall feature definition has a Name Prefix value of D-. This can be 
changed if desired and is set to D-1 in the example above.  
 

• Follow the remaining prompts to place the headwall item on the CULV point. 
 
After a Node is placed in the file, the sofware creates a 3D model in the file. This 3D model is automatically 
attached as a reference to the active model. 
 
The generic headwall node is placed using a triangle symbol on the level 
SC_Scratch1 as shown at right. The direction of the triangle, defined by 
the Rotation parameter, is irrelevant to the flow direction of any links 
connected to the node. 
 
The element drawn in the active 2D model will not match the rotation of 
the element placed in the 3D model so it will appear that two elements 
were placed in the file. Only one node was placed and the second one is the 3D representaion of the node. 

 
• Repeat the process to place a second node at the end of the culvert, using the elevation of the 

second CULV point. 
 
Now that each end of the culvert has been defined with a Node element the culvert can be placed. Take the 
following steps: 
 

• Select the Place Conduit command as shown below 
 

 
 
 
 
 
 
 
 
 

 
The survey crew entered notes for the size of the culvert as shown in the information pop-up for the CULV 
point on the previous page. This is a 12’x6’ box culvert according to the field notes. 
 

• Choose the Existing Box Culvert 12’ Span feature definition as shown below 
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Feature definitions for existing and 
proposed box culverts are provided in the 
OHDOT CADD standards. 
 
The span and rise for each available 
culvert feature is defined by the 
Description field as shown at right above. 
 
Available culvert sizes are based on the 
Figure 1008-14 of the ODOT Location 
and Design Manual – Volume 2, 
Drainage Design. 
 
 
 
 
 
 
 
 
 

 
 

The culvert is placed by selecting each node as shown below. 

 
Two sets of graphics are drawn for the box culvert, one in the active 2D model and another in the 3D model. 
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The Subsurface Utility software creates a 3D model in the drainage basemap named “design-3d” 
containing the 3D model of the box culvert is shown at right below. 

 
To display the 3D view, hold down the right mouse button and choose View Control > 2 Views Plan/3D as 
shown below. 

 
 

• Close and check the design file back in when complete. This concludes this exercise. 
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Examples: Creating a 3D Model of the Existing Utilities 

A 3D model for the existing drainage information may be need by the designers depending on the scope of 
the project. This 3D model is generated in a separate drainage basemap design file (BD) stored in the 400-
Engineering\Drainage\Basemaps\ folder. 
 
The drainage basemap is created using the OHDOT Create Design Files application. The survey data is 
referenced to the drainage basemap. The drainage structures and the pipes are extracted from the survey 
file using the Subsurface Utility commands to generate the 3D model. 
 
Use the OHDOT Create Design Files application is selected from the OHDOT WorkFlow as shown below. 

 
The drainage basemap is created using the settings shown below. See the application documentation for 
additional information. 

 
Notes: 
• Use the 2D seed file to create the drainage basemap. The Subsurface Utilities software will 

generate a separate 3D model in the drainage basemap design file for the 3D drainage information 
• The file is created in the 400-Engineering\Drainage\Basemaps\ folder 
• The two-character file code is “BD”. 
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Extracting the 3D Drainage Nodes 
Bentley’s Subsurface Utility tools are used to generate the 3D model of the existing drainage information. 
Catch basins, manholes, and inlets are referred to as a “node” by the subsurface utility software. 
 
Take the following actions to create a 3D model of the existing drainage information. It is assumed the 
catch basin, manhole, and inlet cells have been rotated into place in the survey basemap before starting this 
process. The application OHDOT Rotate Survey Symbols can be used to rotate selected symbols relative 
to a selected curvilinear element. See the application documentation for more information. 

 
1. Open the newly created drainage basemap (BD) design file. 

 
2. Attach the survey basemap as a reference. 

 
3. Select the Extract from Graphics command, located in the Layout tab of the Subsurface Utilities 

WorkFlow as shown below. 

 
Note: 
If this is the first time you have selected the command, you are prompted to create a utility model. 
Select Yes to create the utility model. 

 
After the utility model is created, you must select the Extract from Graphics command to initiate 
the process. The Extract Utilities From Graphics dialog is accessed as shown on the following 
page. 

 
Take the following steps to extract the utility information. The options can also be selected by use of the 
menu prompts floating on the cursor. 
 

1. Set the Method to Utility Filter. Several filters are provided in the OHDOT CADD Standards for 
individual drainage items as well as groups of items. 
 

2. Use the Select Filter item to choose All Catch Basins filter. This filter is configured to extract only 
the drainage cells for the catch basins and not the pipes. The pipes will be extracted individually as 
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a separate process. 
 

3. Toggle on the Use 3D Element Elevations option. 
 

4. Accept the options as you are prompted on the cursor to initiate the extraction process. 
 

Note: The Design Stage item is not relevant to this process. 

 
The 3D drainage structures are extracted using the elevation of the cells mapped by the Survey process. As 
each drainage structure is processed, the extraction process will search for a FLINE feature to establish the 
depth of the drainage structure. If a FLINE feature is not found, the depth is set using at a default value. 
 
If the drainage basemap was created with a 2D seed file, which is the recommended best practice, the 
Extract Utilities from Graphics process will create a new model named Design-3D containing the 3D 
drainage structures. This new model is automatically attached as a reference to the current 2D model. 
 
In addition to the 3D model, a 2D graphic is placed in the current 2D model for each extracted drainage 
structure nodes. This graphic is linked to the 3D model and can be used to make edits to the drainage 
structure. 
 
In the example below, the reference file display of the survey basemap and the Design-3D model has been 
turned off to show the 2D graphic that is placed for one of the drainage structures. 
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Selecting the graphic reveals a pop-up menu that 
can be used to make edits to the drainage 
structure as well as two rules (Node Top 
Elevation, and Node Rotation) that can be 
edited by selecting the displayed text. 
 
The extracted drainage structures do not take 
into account the rotation angle of the original 
cells and are placed at a zero degree rotation. The 
example at left below shows the original cell as 
referenced from the Survey basemap, and the 2D 
cell that was placed as part of the utility 
extraction process. It is necessary to rotate each 
structure manually. 
 
Once the 2D node is selected, parameters for the 
rotation of the 3D structure are displayed as 
shown at left. The angle can be keyed-in by 
selecting the angle text, or the 3D structure can 
be rotated by selecting one of the rotation 
arrows.  
 
Typically, it is best to get the rotation angle of the 
original cell and use that value to key-in the 
rotation angle for the drainage node as described 
on the following page. 

 
 
 
Take the following steps to key-in the rotation angle for the drainage structure: 
 

✓ Change the Angle Readout as shown below by selecting File > Settings > File > Design File 
Settings 
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✓ Use the MicroStation Element Information command to get the rotation angle of the original cell 

as shown below. 
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✓ Select the drainage node graphic and choose the Properties command from the pop-up menu. The 
Rotation can be modified as shown below. The graphics for the node in the 3D model are updated 
as changes are made to the properties. 

 
 
After extracting the drainage structures and rotating them into place we are ready to extract the pipes.  
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After extracting the graphics, it is necessary to select each structure and manually key-in the Invert 
Elevation value. An example is shown below. 
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Extracting Drainage Links 
The Extract Utilities from Graphics command could be configured to extract pipe information; however, 
as of this writing the current release of the software will not connect the extracted pipes to the previously 
extracted nodes. Even though it is more cumbersome, it is better to place each pipe manually as a “link” 
using the Place Conduit command, shown below. 

 
The dialog shown below is opened. 
 

 
General information for the command can be found by 
selecting Subsurface Utility > Help > Subsurface 
Utilities Help from the MicroStation pull-down menu. 
 
The Feature Definition is used to select the pipe type. 
 
The Description item is used to select the pipe size.  
 
The Name Prefix is used to name each pipe and is 
incremented as you extract the pipes. 
 
 
 

 
When the command is selected, you are prompted to Select Start Node. 
 
The ODOT 3D drainage items have specific connection regions on each side of rectangular structures. 
Circular structures have a circular connection region. When the first node is selected, the link starts from 
one of the connection regions. Follow the prompts to select the second node. An example is shown on the 
following page. 
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A line is placed in the current 3D model that can be used to modify he link. The extruded 3D link is placed in 
the 3D model as shown below. 

 
The link is placed at the lowest elevation of the selected nodes. The elevation values can be edited by 
selecting the link in either the 2D or the 3D model, and then choosing the Properties icon from the pop-up 
menu. 

 
From the Properties menu, shown at left, the Start Invert 
and Stop Invert values can be edited if necessary to set 
the correct elevations for the pipe. 
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Connecting Links to FDO or PIO Points 
The field codes PIO (pipe inlet or outlet) and FDO (for direction only) can both be used to designate the end 
of a pipe. PIO is used to designate an inlet or outlet point for an open pipe of culvert. FDO (for direction 
only), is used to designate the direction of a pipe when the other end cannot be located. 
 
There must be a node defined at the PIO and FDO locations to place a link in the design file using the PIO 
and FDO points. The Place Node command is used to place nodes at the PIO and FDO locations. 
 
The command is selected from the Subsurface Utilities WorkFlow as shown below. 

 
Take the following steps to create nodes for the PIO and FDO points: 
 

• Select the Place Node command 
• Set the Feature Definition to the Pipe Inlet or Outlet-X item 
• When prompted as shown below, issue a reset (right-click) to type in the elevation for the node 

 
• Type in the Elevation for the node 
• Enter a data point for the node location by snapping to the PIO or FDO point 
• A triangle is placed in the 2D and the 3D models at the location of the node. The direction of the 

triangle is irrelevant 
 
The extracted node for the PIO and FDO points is 
placed as a triangle at each point on the level 
SC_Scratch1 as shown at right. 
 
The Place Conduit command described in the 
previous section is used to place the 3D pipes 
between the nodes. 
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Reviewing and Editing Nodes and Links 
After the nodes and links have been created, it is good practice to review the values for accuracy. The 
parameters of the 3D drainage information can be edited by using the MicroStation Element Selection tool 
to select a node or link, and then choosing the Properties icon from the pop-up menu as shown below. 

 
The parameters are shown below. Note that the invert values for a link cannot be edited if the link was 
extracted from graphics. 
 

Link Properties Node Properties 
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Box Culverts 
The graphics for existing storm water utilities are normally placed in a 2D model in the drainage (BD) 
basemap design file. The Subsurface Utility software is used to place the box culvert in a 2D model. The 
software will automatically generate the 3D model for the box culvert. 
 
After creating a drainage basemap design file, attach the survey basemap as a reference file to view the 
culvert shots. Box culverts are surveyed using the CULV field code to take a shot at the invert elevation at 
each end of the culvert. 
 
Box culverts are placed as a link by the Subsurface Utility software by use of the Connect Conduit 
Between Nodes command. A node must first be placed at each end of the proposed box culvert in the 
design file by use of the Place Node command. The generic headwall feature definition is used to defile the 
location of each end of the box culvert.  
 
Select the Place Node command from the task list as shown below. 
 

 
Place a node at each end of the proposed box culvert 
using the Generic Headwall-X feature definition as 
shown above. 
 
The user is prompted to select a reference element 
for the node elevation as shown below.  
 
Nodes can be placed at a specific elevation, or 
relative to the selected surface or a corridor model. 
Issue a Reset to type an elevation. 
 
 
 
 
 
 
 

 
After the elevation reference is defined, the user is prompted to set the Placement Type. 

 
The By Minimum Depth option is used to set the 
initial depth using a default value. The invert elevation 
can be edited after placement if necessary. 
 

 
 

Next the user is prompted to set the location of the node. Place the node at the location of the CULV survey 
point. 
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The generic headwall node is placed using a triangle symbol on the level 
SC_Scratch1 as shown at right. The direction of the triangle, defined by 
the Rotation parameter, is irrelevant to the flow direction of any links 
connected to the node. 
 
After the headwall points have been placed at each end of the culvert, 
the box culvert is placed using the Connect Conduit Between Nodes 
command shown below. 

 
Feature definitions for existing and proposed box 
culverts are provided in the ODOT standards. The 
available features for existing box culverts are shown 
on the following page. The span and rise for each 
available culvert feature is defined by the Description 
field as shown at right above. 
 
 
 
 
 

 
 

 
 

 
 

Available culvert sizes are based on the Figure 1008-14 of the ODOT Location and Design Manual – 
Volume 2, Drainage Design. 
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The culvert is placed by selecting each node as shown below. 

 
 
Two sets of graphics are drawn for the box culvert as shown below. 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

September, 2020 

 

OpenRoads Survey: Existing Utilities and Strom Sewers 400-58 

 

 
The culvert is drawn as a custom line 
style in the 2D model as shown at left. 
The 2D model can be referenced back 
to the survey basemap (BE file) if 
desired, or attached as a reference by 
the design personnel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Subsurface Utility software also creates a 3D model in the drainage basemap named “design-3d” 
containing the 3D model of the box culvert as shown below. 
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OpenRoads Software Version 

This document was prepared using the following software version: 

OpenRoads Designer CONNECT Edition – 2020 Release 2 Update 8 – Version 10.08.01.33 

 

Contacts 

For any questions, suggestions, or problems with this document please contact the ODOT Office of CADD 

and Mapping Services by use of the following form on the ODOT website: 

https://odot.formstack.com/forms/cadd_servicerequest 

 

 

https://odot.formstack.com/forms/cadd_servicerequest

